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!
Danger

indicates that death, severe personal injury or substantial property damage will result if proper precautions
are not taken.

!
Warning

indicates that death, severe personal injury or substantial property damage can result if proper
precautions are not taken.

!
Caution

indicates that minor personal injury can result if proper precautions are not taken.

Caution

indicates that property damage can result if proper precautions are not taken.

Notice

draws your attention to particularly important information on the product, handling the product, or to a
particular part of the documentation.

Qualified Personnel
Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are
defined as persons who are authorized to commission, to ground and to tag circuits, equipment, and
systems in accordance with established safety practices and standards.

Correct Usage
Note the following:

!
Warning

This device and its components may only be used for the applications described in the catalog or the
technical description, and only in connection with devices or components from other manufacturers which
have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed
correctly, and operated and maintained as recommended.

Trademarks
SIMATIC, SIMATIC HMI and SIMATIC NET are registered trademarks of SIEMENS AG.

Third parties using for their own purposes any other names in this document which refer to trademarks
might infringe upon the rights of the trademark owners.

Safety Guidelines
This manual contains notices intended to ensure personal safety, as well as to protect the products and
connected equipment against damage. These notices are highlighted by the symbols shown below and
graded according to severity by the following texts:

We have checked the contents of this manual for agreement
with the hardware and software described. Since deviations
cannot be precluded entirely, we cannot guarantee full
agreement. However, the data in this manual are reviewed
regularly and any necessary corrections included in
subsequent editions. Suggestions for improvement are
welcomed.

Disclaim of LiabilityCopyright � Siemens AG 2001 - 2003 All rights reserved

The reproduction, transmission or use of this document or its
contents is not permitted without express written authority.
Offenders will be liable for damages. All rights, including rights
created by patent grant or registration of a utility model or
design, are reserved.

Siemens AG
Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

 Siemens AG 2001 - 2003
Technical data subject to change.

Siemens Aktiengesellschaft A5E00065531
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Preface

Purpose of the manual

The software and hardware components of the Windows Automation Center
(WinAC) allow you the combined solution consisting of data processing, control,
visualization and communications on your PC (PC-based control). The following
versions of the WinAC product are available:

� WinAC Slot 412

� WinAC Slot 416

This manual will familiarize you with the individual components of the 
WinAC Slot 412 and WinAC Slot 416 product versions by way of an overview. In
addition, you will find instructions for installing the software required for 
WinAC Slot 41x.

Essential basic skills

To understand the manual, general knowledge of automation engineering is
required.

In addition, knowledge of the following is required:

� Extensive knowledge of the S7-400

� Extensive knowledge of STEP 7

Applicability of the manual

The present manual applies to the following modules:

CPU Order No. As of Version 

Firmware Hardware

CPU 412-2 PCI 6ES7 612-2QH00-0AB4* 3.1 1

CPU 416-2 PCI 6ES7 616-2QL00-0AB4* 3.1 1

PS extension board 6ES7 678-1RA00-0XB0 - 1

* As spare part
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Changes from the previous version

The following changes have been made compared to the previous version of
WinAC Slot 41x, version 3.2:

� You can also operate WinAC Slot under Windows XP Professional.

� Windows NT 4.0 is no longer support.

� You can update process image partitions synchronous to the DP clock using
SFC 126 “SYNC_PI“ und der SFC 127 “SYNC_PO“

� You can determine the bus topology of a DP master system by triggering the
diagnostics repeater with SFC 103 ”DP_TOPOL”.

Certification

The CPUs 41x-2 PCI and the PS extension board have the following certification:

� Underwriters Laboratories, Inc.: UL 508 registered 
(Industrial Control Equipment)

� Canadian Standards Association: CSA C22.2 number 142, 
(Process Control Equipment)

� Factory Mutual Research: Approval Standard Class Number 3611.

CE Labeling

The CPUs 41x-2 PCI and the PS extension board fulfil the requirements and
protection guidelines of the following EU directives:

� EC Directive 73/23/EEC “Low–voltage directive”

� EC Directive 89/336/EWG “EMC directive”

CTick Mark

The CPUs 41x-2 PCI and the PS extension board are compliant with requirements
of the  AS/NZS 2064 (Australian) standard.

Standards

The CPUs 41x-2 PCI and the PS extension board fulfil the requirements and
criteria of IEC 61131-2.

Refer to appendix xx to find out the norms the CPUs are compliant with.
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Package as supplied

This package has the order number 6ES7 673-6CC01-8BA0 and consists of three
manuals and an operation list containing the following:

Overview of the Windows Automation Center WinAC Slot 412/WinAC Slot 416

� Overview of the components of WinAC

� Getting started

Manual ”WinAC Controlling with CPU 412-2 PCI/CPU 416-2 PCI; Set-Up, CPU Data”

� Installing and wiring CPUs 41x-2 PCI and the PS extension board

� Instructions for installing the software

� Commissioning CPUs 41x-2 PCI and the  PS extension board

� Description of control panel, time synchronization

� Technical specifications

� Compatibility with version 3.2 of WinAC Slot 41x

Manual ”SIMATIC Computing”

� Function and running of the SIMATIC Computing software

� Description of the controls

S7-400 instruction list
� Instruction set for all CPUs

� Brief description of instructions and execution times

� List of OBs, system events, SSL IDs, SFCs/SFBs

Recycling and Disposal

The CPUs 41x-2 PCI and the PS extension board are  recycleable due to their
non-toxic materials. Please contact a company certified in the disposal of
electronic scrap for environmentally safe recycling and disposal of your old device.

Further Support

If you have any technical questions, please get in touch with your Siemens
representative or agent responsible.

http://www.siemens.com/automation/partner

Training Centers 

Siemens offers a number of training courses to familiarize you with the SIMATIC
S7 automation system. Please contact your regional training center or our central
training center in D 90327 Nuremberg, Germany for details:

Telephone:  +49 (911) 895-3200.

Internet: http://www.sitrain.com

http://www.siemens.com/automation/partner
http://www.sitrain.com
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A&D Technical Support

Worldwide, available 24 hours a day:

Johnson City

Nuernberg

Beijing

Technical Support

Worldwide (Nuernberg)

Technical Support

24 hours a day, 365 days a year

Phone: +49 (0) 180 5050-222

Fax: +49 (0) 180 5050-223

E-Mail: adsupport@
siemens.com

GMT: +1:00

Europe / Africa (Nuernberg)

Authorization

Local time: Mon.-Fri. 7:00 to 17:00

Phone: +49 (0) 180 5050–222

Fax: +49 (0) 180 5050-223

E-Mail: adautorisierung@
siemens.com

GMT: +1:00

United States (Johnson City)

Technical Support and
Authorization
Local time: Mon.-Fri. 8:00 to 17:00

Phone: +1 (0) 423 262 2522

Fax: +1 (0) 423 262 2289

E-Mail: simatic.hotline@
sea.siemens.com

GMT: –5:00

Asia / Australia (Beijing)

Technical Support and
Authorization
Local time: Mon.-Fri. 8:30 to 17:30

Phone: +86 10 64 75 75 75

Fax: +86 10 64 74 74 74

E-Mail: adsupport.asia@
siemens.com

GMT: +8:00

The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English.
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Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

� The newsletter, which constantly provides you with up–to–date information on
your products.

� The right documents via our Search function in Service & Support.

� A forum, where users and experts from all over the world exchange their
experiences.

� Your local representative for Automation & Drives via our representatives
database.

� Information on field service, repairs, spare parts and more under “Services”.

http://www.siemens.com/automation/service&support
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Automation and Drives, service and support

Available throughout the world at any time of the day:

Johnson City

Nuremberg

Singapore

SIMATIC Hotline

Worldwide (Nuremberg)

Technical Support

(FreeContact)

Local time:
Mon. through Fri. 7 a.m. to 5 p.m.

Phone: +49 (180) 5050-222

Fax: +49 (180) 5050-223

E-mail: techsupport@
ad.siemens.de

GMT: +1:00

Worldwide (Nuremberg)

Technical Support

(subject to charge, with SIMATIC Card
only)
Local time:
Mon. through Fri. 0 a.m. 12 p.m.

Phone: +49 (911) 895-7777

Fax: +49 (911) 895-7001

GMT: +01:00

Europe / Africa (Nuremberg)

Authorization

Local time:
Mon. through Fri. 7 a.m. to 5 p.m.

Phone: +49 (911) 895-7200

Fax: +49 (911) 895-7201

E-mail: authorization@
nbgm.siemens.de

GMT: +1:00

America (Johnson City)

Technical Support and
Authorization
Local time:
Mon. through Fri. 8 a.m. to 7 p.m.

Phone: +1 423 461-2522

Fax: +1 423 461-2289

E-mail: simatic.hotline@
sea.siemens.com

GMT: -5:00

Asia / Australia (Singapore)

Technical Support and
Authorization
Local time:
Mon. through Fri. 8:30 a.m. to 5.30 p.m.

Phone: +65 740-7000

Fax: +65 740-7001

E-mail: simatic.hotline@
sae.siemens.com.sg

GMT: +8:00

Generally speaking, the languages spoken on the SIMATIC Hotlines are English and German, while French, Italian and
Spanish are also spoken on the Authorization Hotline.
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Product Overview

Overview

The WinAC Slot 41x package consists of the following components:

� the Slot PLC ”CPU 412-2 PCI” or “CPU 416-2 PCI”, two CPUs from the range
of products for the S7-400 for PC-based applications.

� the optional PS extension board (PS: power supply; power supply module) for
PC-independent power supply.

� the control panel that displays the controls of the CPU 41x-2 PCI on a screen.

� the time synchronization for synchronization of the CPU 41x-2 PCI via a
SIMATIC NET CP (Industrial Ethernet or PROFIBUS).

� the SIMATIC Computing software. The SIMATIC Computing software provides
ActiveX controls, which you can use specifically to visualize your process. In
SIMATIC Computing, you can use third-party ActiveX controls in addition to S7
Controls to monitor and modify process data.

Furthermore, SIMATIC Computing has an OPC server (OPC = OLE for
Process Control) which other OPC applications use to access the data in the
controlled device.

1
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1.1 What is PC-based Automation with SIMATIC WinAC?

PC-based automation with SIMATIC WinAC

In the top range of the PLC applications, the number of PC tasks such as data
processing and visualization is increasing. The use of PC-based automation with
SIMATIC WinAC then frequently represents a better solution. PC-based
automation with SIMATIC WinAC is the combination of a PLC and data processing
on a PC with WinAC Slot 412/WinAC Slot 416.

SIMATIC WinAC combines the automation tasks of open-loop and closed-loop
control, data processing, communications and visualization on a PC.
SIMATIC WinAC is based on the Windows 2000 Professional and Windows XP
Professional and uses standard interfaces for integration into the Office world.
SIMATIC WinAC can be used on SIMATIC PCs and all commercial PCs with
Windows 2000 Professional or Windows XP Professional. WinAC stands for
Windows Automation Center.

Access to process data

SIMATIC WinAC features an ActiveX interface for simple symbolic access to
process data from standard Windows applications such as Excel and Access.
Furthermore, there are WinAC ActiveX Controls for the display of diagnostic buffer
contents and simple display and operator controls.

The integrated OPC server of SIMATIC WinAC features open–system access to
the process data by any OPC client applications.

Connection to visualization

An OPC server with a data access interface is avaialble for integrating all kinds of
visualization system based on Windows 2000/XP. SIMATIC WinCC and
ProTool/Pro can be connected through an optimized interface.

Communication

Communication runs over S7 communication services or TCP/IP by means of 
DCOM mechanisms.

Technology on the PC

For a rapid exchange of data between the CPU 41x-2 PCI and PC, you can create
a technological application using the WinAC Slot T-Kit.
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1.2 CPU 41x-2 PCI Is for Controlling Your Process

CPU 41x-2 PCI features an effective hardware solution for your automation
projects (refer to Figure 1-1). The I/O is connected via PROFIBUS-DP.

Distributed I/O

CPU 41x-2 PCI

Figure 1-1 Using the CPU 41x-2 PCI in WinAC Slot 41x

WinAC Controlling with CPU 41x-2 PCI

WinAC Controlling is the control component with WinAC Slot 412/ WinAC Slot 416.
WinAC Controlling performs the tasks of a conventional programmed logic
controller and is completely integrated in the PC.

WinAC Controlling consists optionally of the CPU 412-2 PCI or CPU 416-2 PCI.
These CPUs exhibit typical PLC features:

� warm restart (restart) or precise complete restart as commanded (with
PS extension board)

� deterministic behavior with real–time response times

� real-time clock

� data retentivity using battery backup (with PS extension board)

� external load memory for saving the PLC program independently of the PC hard
disk

� integrated MPI for connecting a programmer for servicing purposes, for
programming or for networking with other stations

� integrated PROFIBUS-DP interface for connecting the I/O

Furthermore, there are interfaces to PC applications.
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Operation

The CPU 41x-2 PCI is operated from control panel that is displayed on the PC
screen. The panel is modeled on the front panel of an S7 CPU and makes
available the functions that it features.

Access to the PLC from the control panel can be protected by a password so that
only authorized persons can modify the settings.

Shows the status of the
CPU 41x-2 PCI.

Resets the memory areas

Sets the operating mode
of the CPU 41x-2 PCI.

Figure 1-2 Control Panel

Programming

Configuration and programming of the CPU 41x-2 PCI is accomplished in a
manner similar to that for the SIMATIC S7 with STEP 7. For these tasks, you can
use the programming languages LAD, CSF, STL, S7-SCL and all graphics
programming languages such as S7-GRAPH, S7-HiGRAPH and CFC.
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1.3 The PS Extension Board Enhances Safety in Operation

The PS extension board (PS: power supply) is used to supply voltage to the
CPU 41x-2 PCI independently of the PC power supply unit. In this way it is
possible to operate the CPU 41x-2 PCI even when the PC has been powered
down.

By connecting the backup battery, warm restart (restart) and complete restart are
possible for the CPU 41x-2 PCI.

In addition, you can operate the fan on the PC with the PS extension board.

Figure 1-3 PS Extension Board
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1.4 Communication Options with CPU 41x-2 PCI

ET 200M
ET 200S

PG/PC PG/PC

OP/OS PG/PC

Industrial Ethernet

PROFIBUS-DP

S7 routing

Visualization
WinCC
Pro Tool/Pro
Softnet S7

Visualization
OPC server S7

Engineering
STEP 7

WinAC Slot 41x
with CPU 41x-2 PCI

MPI/DP*

Engineering
STEP 7

*: transfer via STEP 7/Configure Hardware

PC

Figure 1-4 Communication Options with the CPU 41x-2 PCI

Figure 1-4 shows the communication options open to you with the CPU 41x-2 PCI.
The CPU 41x-2 PCI has one PROFIBUS-DP interface and one
MPI/PROFIBUS-DP interface.

If you wish to perform communications via Industrial Ethernet or PROFIBUS
subnet, you must install an additional communication processor (CP) on your PC.

The communication options with other nodes are:

1. Connection to PROFIBUS-DP through the integrated interface.

2. Connection to MPI or PROFIBUS-DP through the second integrated interface.

3. Connection to PC through the PCI interface.

4. Connection to another network such as Industrial Ethernet/PROFIBUS via a
communication processor (CP).
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Communication key data

Communication is possible with a PG or an OS, and configured AS/AS
communication (with other CPUs) is possible over Industrial Ethernet, MPI or
distributed I/O. The following interfaces can be used: CP 1613, 3Com Softnet,
CP 5613, CP 5611 and the integrated interfaces.

Constraints: the FMS und FDL protocols and AG-Send/AG-Receive are not
supported.

Table 1-1 Communication key data

CP/Interface Protocol Time Syn-
chroniza-

Number of Con-
nections over 

Communication over WinAC
Slot 41x

tion Possi-
ble

WinAC Slot 41x1,

2 Communica-
tion with PG,

OS, etc.

Configured
AS/AS Com-
munication

CP1613 Industrial Ethernet Yes 120 Yes Yes

3Com 
Softnet

Industrial Ethernet Yes 64 Yes Yes

CP 5613 PROFIBUS Yes 50 Yes Yes

MPI No – No No

CP 56113, 4 PROFIBUS No 8 Yes Yes

MPI No – No No

Integrated in-
terfaces

PROFIBUS Yes CPU 412-2 PCI:16
CPU 416-2 PCI: 32

Yes Yes

MPI Yes CPU 412-2 PCI: 16
CPU 416-2 PCI: 44

Yes Yes

1 The number of connections apply to Credit = 1 and PDU size = 480 bytes. For other settings please refer
to the product information for SIMATIC NET for additional information.
2 With the CPU 412-2 PCI a maximum of 16 connections is allowed, and with the CPU 416-2 PCI a
maximum of 64 connections are allowed.
3 If you are routing via the CP 5611 or the integrated interface of the SIMATIC PC, you must make sure,
when setting the access point with ”Set PG/PC Interface”, that you have selected the property ”PG/PC is
the sole master on bus” at ”Station-specific properties”in the properties dialog box of the CP 5611.
4 When using the CP 5611 in a dual Pentium PC, Windows NT can sporadically become inoperable. The
only remedy is to power down and power up.
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1.5 Time Synchronization (PLCTimeSync)

The CPU 41x-2 PCI can be synchronized, together with other nodes (for example,
S7 components) with a central time-of-day transmitter.

The time synchronization service in the PC supplies the CPU at intervals with the
current date and time. The time-of-day transmitter furnishes the time of day at
periodic intervals on the Industrial Ethernet or PROFIBUS (IE/PB). Only the ISO
protocol is supported by Industrial Ethernet.

Clock synchronization

PC

Industrial Ethernet (IE)
PROFIBUS-DP (PB)

OP/OS

S7 Station
PG/PC

CPU 41x-2 PCI IE CP or PB CP

Time-of-day
transmitter

Figure 1-5 Clock synchronization
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1.6 SIMATIC Computing Creates Access to Process Data

In Figure 1-6, you can see how you can use the SIMATIC Computing software to
access the CPU 41x-2 PCI for monitoring and modifying process data.

SIMATIC Computing provides several methods for accessing the process data:

� You can use standard ActiveX controls (OCX) to access the process data.

� You can use DCOM (Microsoft’s Distributed Component Object Model) to
integrate distributed applications across a network. A distributed application
consists of several processes or different computers that cooperate to jointly
solve a task (refer to section 1.9).

� You can use an OPC (OLE for Process Control) server which other OPC clients
use to access the data in the controlled device (refer to section 1.10).

S7SoftContainer - [S7Soft1]

�

File Edit View Mode Options Window   Help

Ready

S7Soft1
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ

Design

SIMATIC Computing

File CPU Help

PS

CPU

ON

INTF

EXTF

BUSF1

BUSF2

FRCE

RUN

STOP

RUN

RUN-P

MRES

STOP

OFF

ON

CPU 416-2 PCI

BATF

Figure 1-6 Accessing the Process Data with SIMATIC Computing
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1.7 Tag Files Allow You To Use Symbols for Process Data...

A tag file provides a source of symbolic information for memory locations and
control engines. Linking to a tag file allows you to use symbolic names instead of
absolute addresses when assigning tags in SIMATIC Computing (refer to Figure
1-7).

The TagFile Configurator creates a tag file that provides a source of symbolic
information for the memory locations and control engines. The tag file can then be
used on a computer on which STEP 7 is not installed.

Refer to the SIMATIC Computing User Manual for detailed information about using
the TagFile Configurator.

SIMATIC Projects

Master_Mixer
@PC_1

WinAC
Mixer

Tag File

Control Engine Symbol STEP 7 Path

PC_1_WinAC WinAC\@PC_1\WinAC\Mixer

STEP 7

Computer Name

@PC_1

CPU
41x-2 PCI

Distributed
I/O

The tag file includes the symbol
table and the control engine for the
STEP 7 project

Figure 1-7 Using STEP 7 Symbols to Access Data in the Control Engine
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1.8 Tag Files Allow You to Access Multiple Control Engines...

Every STEP 7 program can be assigned to a tag table, with each program
providing access to a different computer and a different control engine. This allows
SIMATIC Computing to access data from different computers and control engines
simultaneously.

As shown in Figure 1-8, you can connect your program to control engines residing
on several different computers. You use the TagFile Configurator to insert more
than one control engine into a tag file. Refer to the SIMATIC Computing User
Manual for detailed information about using the TagFile Configurator.

PC 1

CPU 41x-2 PCI

 SIMATIC
Computing

PC 2

PC 3

SIMATIC Projects

Master_Mixer
@PC_2

WinAC
Mixer

Tag File

Control Engine Symbol STEP 7 Path

PC_2_WinAC WinAC\@PC_2\WinAC\Mixer

SIMATIC Projects

My_Drain
@PC_3

WinAC
Drain

STEP 7 STEP 7

Computer Name

@PC_2

PC_3_WinAC WinAC\@PC_3\WinAC\Mixer @PC_3

CPU 41x-2 PCI

Figure 1-8 Using a Tag File to Access Data from Several Control Engines
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1.9 Use SIMATIC Computing across a DCOM Network

Microsoft’s Distributed Component Object Model (DCOM) is a set of program
interfaces in which client program objects can request services from server
program objects on other computers in a network.

In WinAC, you can connect distributed applications across a network using DCOM
(refer to Figure 1-9). A distributed application consists of multiple processes or
different computers that cooperate to accomplish a single task jointly. 

Net-
work

Client

DCOM 
components

I/O

DCOM 
components

 SIMATIC
Computing

PC 1

CPU 41x-2 PCI

PC 2

Server

Figure 1-9 Connecting WinAC on Several Computers across a DCOM Network
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1.10 Using OPC to Connect Third-Party Applications to
SIMATIC Computing

OLE for Process Control (OPC) provides a standard mechanism for
communicating with numerous data sources. It is immaterial in this case whether
these sources are machines in your factory or a database in your control room.
OPC is based on the OLE/COM technology from Microsoft. For more information
about OPC, refer to the OPC specification OLE for Process Control Data Access
Standard, version 2.0 from the OPC Foundation.

The OPC Foundation address can be reached on the Internet at 
http://www.opcfoundation.org

As shown in Figure 1-10, you can use the OPC server provided with the SIMATIC
Computing software to communicate with the control engine and provide access to
the process data. SIMATIC Computing provides an OPC server that allows any
OPC client application to access data in the control engine. SIMATIC Computing
does not provide any OPC client application.

The OPC server is called: OPCServer.WinAC

SIMATIC Computing allows you to use OPC for connecting either to a single
control engine or to several control engines. You can also connect to the control
engine across a network, such as a local area network (LAN).

MPI = n

CPU 416-2PCI*

WinAC OPC server:

OPCServer.WinAC

 SIMATIC Computing

Third–party application 
(OPC client)

MPI server

WinLC*

I/OI/O

MPI card

OPC

*: cannot be operated
simultaneously

Figure 1-10 Using OPC to Connect Third-Party Applications to SIMATIC Computing

http://www.opcfoundation.org
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1.11 Tool Manager Provides Shortcuts to Your Programs

The WinAC Tool Manager is a toolbar that lets you consolidate all of the
applications that you want to use while working with your process data. For
instance, if you plan to use Visual Basic with WinAC Slot 41x or want to put
process data into a Microsoft Excel spreadsheet, you can insert shortcuts to those
items on the WinAC Tool Manager. The WinAC Tool Manager is especially
convenient for users who do not have a mouse on their computer, since all of the
functions of the WinAC Tool Manager can be accessed by keystrokes from one
central location.

Figure 1-11 shows the WinAC Tool Manager and its shortcut icon. You can insert
shortcut icons for any of your programs into the WinAC Tool Manager tray. You
then use the WinAC Tool Manager to start these programs. 

WinAC Tool Manager

WinAC Tool Manager

S7 logo empty tray

WinAC
Tool Manager

Shortcut icon

Figure 1-11 WinAC Tool Manager and Shortcut Icon
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Getting Started

In this chapter

Section Contents Page

2.1 Problem Definition: Communication from the CPU 416-2 PCI over
the CP 1613 to a S7-400

2-2

2.2 Starting the Control Panel of WinAC Slot 41x 2-16

2.3 Going Online with STEP 7 to the CPU 41x-2 PCI 2-17

2.4 Creating a Process Form with SIMATIC Computing SoftContainer 2-20

2.5 Establishing Connections for the Process Form 2-22

Information on this Getting Started

In this chapter you will learn how to work with WinAC Slot 41x as demonstrated by
an example of establishing a connection. We will perform practical exercises to
show you the most important screen-based dialog boxes and approaches.

It will be helpful if you are already in a position to work with a mouse, windows,
pull-down menus, etc. and have a basic knowledge of PLCs.

There are training courses in which you can add to the knowledge you have
acquired with Getting Started and learn how to create complete automation
solutions with STEP 7.

Examples in the documentation for SIMATIC Computing

You will find further examples for working with SIMATIC Computing in the SIMATIC
Computing documentation.

2
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Requirements for working with Getting Started

To be able to perform the practical exercise in this Getting Started, you will need:

� a Siemens programming device or a PC

� the STEP 7 software package and the authorization disk

� a SIMATIC S7-400 automation system

We wish you lots of pleasure and success.
Your SIEMENS AG

2.1 Problem Definition: Communication from the
CPU 416-2 PCI over the CP 1613 to a S7-400

In this chapter

Section Contents Page

2.1.1 Installing the components of WinAC Slot 41x 2-4

2.1.2 Component Configurator: Assigning Station Names 2-5

2.1.3 Commissioning wizard: assigning CP 1613 2-6

2.1.4 Creating a Project in SIMATIC Manager 2-8

2.1.5 Configuring the Hardware of the Box PC 620 2-9

2.1.6 Configuring the Hardware of the S7-400 Station 2-12

2.1.7 Configuring a Network 2-13

2.1.8 Configuring a Connection 2-14

2.1.9 Communications 2-16
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Example:

In our example, we want to connect a PC station to a CPU 416-2 PCI and a
SIMATIC S7-400 station via Industrial Ethernet (IE).

PC

Industrial Ethernet

S7 Station

CPU 416-2 PCI CP 1613

Figure 2-1 Communication over CP 1613 to a S7-400
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2.1.1 Installing the Components of WinAC Slot 41x

The WinAC Slot 41x software includes a setup feature for each CPU type that
performs automatic installation.

The Setup program guides you step by step through the installation process. You
can switch to the next step or to the previous step from any position. To start the
installation program, proceed as follows:

1. Insert the CD in your CD-ROM drive.

2. Double-click the “setup.exe” file to select it.

Result: Figure 2-2 shows the dialog box that allows you to choose which
components to install.

Figure 2-2 Installing the Components of WinAC Slot 41x

3. Select the components that you want to install. Setup automatically highlights
the components that it could not find on your PC.

Once the installation has been completed successfully, a message to that effect is
displayed on the screen.

Note

You will find detailed information about installing WinAC Slot 41x in the manual
WinAC  Controlling with CPU 412-2 PCI/CPU 416-2 PCI; Set–Up,
CPU–Data Version 3.2.
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2.1.2 Component Configurator: Assigning Station Names

Function of the component configurator

You notify the following settings to the PC with the help of the component
configurator:

� Station name,

� Type of CPU 41x-2 PCI and

� Name of CPU 41x-2 PCI.

Note

The settings in the component configurator must match the subsequent configura-
tion in “STEP 7/Configure Hardware”:

� Station name

� Type

� Index (corresponds to the slot in “Configure Hardware”) and

� Name.

Index

The CPU 41x-2 PCI is automatically operated on index 3. The index corresponds
to a virtual slot on the PC.

Name

Note

The name that you assign to the CPU 41x-2 PCI with STEP 7 then corresponds to
the name by which you call the control panel of the CPU from the taskbar. If, for
example, you assign the name Slot_CPU to the CPU 41x-2 PCI, call the control
panel at Start > Simatic > PC Based Control > Slot_CPU.

Information about the component configurator

You will find more information about diagnostics in the component configurator, for
example, in the appropriate online Help.
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Procedure

To assign the name to the PC

1. Open the component configurator by clicking on the 

button  on the taskbar.

Result: The component configurator opens.

2. Click on “Station name”.

3. Call the station “Box PC 620” and terminate by clicking “OK”.

Figure 2-3 Component Configurator: Assigning Station Names

4. Exit the component configurator by clicking on “OK”.

2.1.3 Commissioning wizard: assigning CP 1613 

Function of the commissioning wizard

You require the commissioning wizard to notify the CPs that have been plugged in
to the PC.

Note

The settings in the commissioning wizard must be identical to those in the subse-
quent configuration in “STEP 7/Configure Hardware”.

Information about the commissioning wizard

You will find more information about the commissioning wizard in the associated
documentation and in the online Help.
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Procedure

To configure the CP 1613 for operation within the PC, perform the following steps:

1. Open the commissioning wizard by choosing Start > SIMATIC > SIMATIC NET
> Settings > Commissioning Wizard from the menu.

Result: The  “SIMATIC NET Commissioning Wizard” window opens.

2. Click on “Next”.

Result: The “PC Station Configuration” window opens.

3. Fill out the settings for the CP 1613 as shown in the figure below and confirm
by clicking “Next”.

Note

The settings (index, MAC address, IP address, subnet mask) must be identical to
those in “STEP 7/Configure Hardware”. The index in “STEP 7/Configure Hard-
ware” corresponds to the slot.

Figure 2-4 Commissioning wizard: settings for CP 1613

Result: You have then entered all the important settings for this Getting
Started.

4. Click “Next” or “Finish” as often as is necessary to quit the commissioning
wizard.
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2.1.4 Creating a Project in SIMATIC Manager

Perform the following steps:

1. Create a project called ”START_SLOT”.

2. Insert Box PC 620 by entering Insert > Station > SIMATIC PC Station and call
the PC station Box PC 620.

3. Insert the S7-400 station by entering Insert > Station > SIMATIC 400 Station
and call the SIMATIC S7-400 station S7-400.

Figure 2-5 Creating a Project

Note

The following settings in the component configurator must match the subsequent
configuration in “STEP 7/Configure Hardware”:

� Station name

� Type

� Index (corresponds to the slot “Configure Hardware”)

� Name.
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2.1.5 Configuring the Hardware of the Box PC620

Selecting a subrack

1. Select Box PC 620.

2. Open “HW Config” by double–clicking “Configuration”.

3. Open the catalog and branch to SIMATIC PC Station > Controller >
CPU 416-2 PCI > 6ES7 616-2QL00-0AB4 > V3.1.

4. Drag and drop the CPU 416-2 PCI onto slot 3.

Slot 3 corresponds to index 3 in the component configurator. The slot and index
must always be the same.

Result: the “Properties – PROFIBUS Interfaces DP Master” opens.

5. Do not connect the subnet for the DP master.

6. Click ”OK” to apply the settings.

Figure 2-6 Selecting a Mounting Rack
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Assigning a CP

1. Branch to SIMATIC PC Station > CP Industrial Ethernet.

2. Drag and drop CP 1613 into slot 4.

Figure 2-7 Assigning a CP

Slot 4 corresponds to index 4 in the component configurator. The slot and index
must always be the same.

Result: the “Properties – Ethernet Interface CP 1613” dialog box opens.
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Figure 2-8 CP 1613: Properties of the Ethernet Interface

3. Fill out the properties of the Ethernet interface as shown in Figure 2-8 (create
the MAC address and a new subnet) and confirm by clicking on “OK”.

4. Close with ”Save and Compile”.
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2.1.6 Hardware configuration of the S7-400 Station

1. Select the components listed below and configure them as shown 
in Figure 2-9.

� Rack

� Power supply

� CPU 416-1

� CP 443-1

2. Fill out the properties of the Ethernet interface (create the MAC address and a
new subnet) and confirm by clicking on “OK”.

3. Close with ”Save and Compile”.

Figure 2-9 Configuring the Hardware of the S7-400 Station
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2.1.7 Configuring a Network

1. Open NetPro by clicking on the “Configure Network” button.

Result: The NetPro – [START_SLOT] window opens.

Figure 2-10 Configuring the Network
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2.1.8 Configuring a Connection

A connection defines the communication relationship between two nodes. The
following parameters are specified in it:

– The two communication nodes

– The type of the connection (in this case an S7 connection)

– Specific properties that depend on the type of the connection (whether a
connection remains open continuously, for example, or whether it is
established and cleared dynamically in the user program).

To enter a connection, proceed as follows:

1. Select the ”CPU 416-1 PCI” module (the connection table is visible).

2. Double–click a blank line in the connection table, or choose Insert > New
Connection...  from the menu. As a result, the ”New Connection” dialog box
opens.

Figure 2-11 Creating a Connection

3. In the ”Station” and ”Module” boxes, select the programmable module to which
the connection is to lead (also referred to as a connection partner or remote
node).

4. Select the connection type (S7 connection only) in the ”Type” box.

5. Select the ”Open Properties Dialog Box” check box.



Getting Started

2-15
Windows Automation Center WinAC Slot 412/WinAC Slot 416 Version 3.3
A5E00065531-05

6. Confirm with ”Apply”. The ”Properties - S7 Connection” dialog box opens (refer
to Figure 2-12).

Figure 2-12 Connection Properties

7. Check the settings (interface and type) as in Figure 2-12

8. Accept your entries by clicking ”OK”.

The first connection has thus been created.

STEP 7 enters the connection in the connection table of the local node and
assigns to this connection the local ID and, if applicable, the partner ID that you
require when programming the communication function blocks (value for the ”ID”
block parameter).

These settings conclude the configuration of the ”START_SLOT” project.

9. Compile with the “Save and Compile” button.

10.Load the data in the relevant station.
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2.1.9 Communications

Embed the appropriate communication blocks (for example, Put/Get) in your user
program.

2.2 Starting the Control Panel of WinAC Slot 41x

To call WinAC Slot, choose the following command from the Windows Start
menu:Start > SIMATIC > PC Based Control > CPU 41x-2 PCI or the symbolic
name of the CPU that you assigned to the CPU 41x-2 PCI in the component
configurator.

The control panel of the CPU 41x-2 PCI then opens (Figure 2-13). You control the
operations of the CPU 41x-2 PCI with this control panel.

Select the RUN, RUN-P or STOP
button to set the status of the CPU.

Status displays show the status of
the CPU (WinAC Slot).

Figure 2-13 Calling the WinAC Slot Controller
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2.3 Going Online with STEP 7 to the CPU 41x-2 PCI

Connecting STEP 7 to CPU 41x-2 PCI on the same computer

Perform the following steps if you would like to configure STEP 7 for
communication with the CPU 41x-2 PCI on the same computer.

1. Open the interface application in WinAC Slot using the following command: 
(CPU > Set PG/PC Interface).

2. Perform the following work steps to set up STEP 7 as a local access point:

– At “Access point of application”, select S7ONLINE (STEP 7) (Figure 2-14).

– At “Used parameter set”, select PC Internal (Local) as the interface
parameter.

STEP 7 is now configured for communication with the CPU 41x-2 PCI on the same
computer.

Figure 2-14 Setting the PG/PC Interface for PC Internal (Local)
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Connecting STEP 7 with CPU 41x-2 PCI on a different computer

As you can see in Figure 2-15, you can connect STEP 7 to the CPU 41x-2 PCI
residing on a different computer. You have to define the network connection over
which STEP 7 and the CPU 41x-2 PCI communicate by setting the PG/PC
interface on the remote computer.

STEP 7 must be installed on the remote computer, and the CPU 41x-2 PCI has to
be installed on the computer with which you wish to establish a connection.

PC 2PC 1

Network

Set PG/PC Interface

STEP  7

Computer with STEP 7 Computer with CPU 41x-2 PCI

CPU 41x-2 PCI

Hard-
ware
AS

Hard-
ware
AS

Figure 2-15 Connecting STEP 7 to WinAC Slot over a Network
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Perform the following steps if you would like to configure STEP 7 for
communication with WinAC Slot on a remote computer.

1. Call the application for interface configuration from the control panel of the
CPU 41x-2 PCI. To do this, choose the command (CPU > Set PG/PC
Interface) (Figure 2-16).

Figure 2-16 Setting the PG/PC Interface

2. At ”Access point of application”, select S7ONLINE (STEP7).

– At MPI Communication, select an MPI type interface, such as CP5611(MPI).

– At PROFIBUS-DP Communication, select a PROFIBUS-DP interface, such
as CP5611(PROFIBUS).

The PROFIBUS connection of the CPU 41x-2 PCI must be fully installed using
the application Set PG/PC Interface before the CPU 41x-2 PCI is visible on
other PGs in the PROFIBUS-DP network (S7ONLINE (STEP7)
--><name of card> Profibus.... Select the ”Properties” button. On the
”PROFIBUS” tab, select the check box ”PG/PC is sole master on bus”.
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2.4 Creating a Process Form with SIMATIC Computing
SoftContainer

Setting the access point for SIMATIC Computing

Before working with SIMATIC Computing, you must set the access point of the
application.

1. On the control panel of the CPU 41x-2 PCI, go to CPU > Set PC/PG Interface.

2. Set the access point of the application to “COMPUTING –> PC internal”.

Figure 2-17 Setting the PG/PC Interface for SIMATIC Computing

3. Click ”OK” to apply the settings.
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SIMATIC Computing

SIMATIC Computing has a SoftContainer, which is an OLE container for ActiveX
controls. You can use SoftContainer to create process forms with which you can
access the control engine (such as CPU 41x-2 PCI).

The SoftContainer toolbar contains buttons for the SIMATIC controls, which are
provided by the SIMATIC Computing software. You can use these buttons as a
simple option for inserting the controls in a process form. You can also include
other ActiveX controls in a process form (and also in the toolbar of SoftContainer).

Creating a process form

To call SoftContainer and a blank process form, choose the following command
from the Windows Start menu: Start > Simatic > PC Based Control > SIMATIC
Computing SoftContainer. (You can also double–click with the mouse on the
SIMATIC Computing button.)

Figure 2-18 shows SoftContainer with a blank process form (S7Soft1).

Choose the command File > Save As... from the menu to open the ”Save As”
dialog box. Give the process form the name START_SLOT and save the process
form.

SoftContainer - [S7Soft1]

�

File Edit View Mode Options Window     Help

Ready

S7Soft1

ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ

Design

Button for inserting a
button control

Toolbar

Button for inserting a data
control

Blank process form (name:
S7Soft1)

Figure 2-18 SoftContainer with Blank Process Form; Inserting a SIMATIC Control in a

Process Form
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1. Insert a data control (refer to Figure 2-19):

– Click on the button for the data control.

– Move the cursor to the process form.

– Left click to insert the data control in the process form.

�

File Edit View Mode Options Window   Help

Ready

Traffic lights
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ

Design

Select the button for the data con-
trol from the toolbar.

The mouse pointer is trans-
formed into a cross-hair pointer
within the container.

Left click to insert the control.

SoftContainer - [START_SLOT]

Figure 2-19 Inserting a SIMATIC Data Control from the Toolbar

2.5 Establishing Connections for the Process Form

The SIMATIC controls have dialog boxes, in which you can set up the properties of
the controls. In this example, you perform the following task in the “Properties”
dialog box of the data control:

� Set the control engine (in this example, CPU 41x-2 PCI)
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Opening the ”Properties” dialog box for the data control

Perform the following steps to open the “Properties” dialog box for the data control:

1. If the data control has not been selected yet, select the data control (S7Data1).

2. As Figure 2-20 shows, double-click on the data control (or right click and
choose from the popup menu the command S7Data1 Properties) in order to
display the “Properties” dialog box of the data control.

�
File  Edit  View  M  ode Options  W  indow  Help

S7Soft1

ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ
ÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎÎ

Siemens S7Data Control Properties

Connections EventsGeneral

100

100

AutoConnect Timeout (ms):

Default Update Rate (ms):

0Default Dead Band:

AutoConnect:

Show Error Boxes:

OK Cancel Apply Help

Engine Name

Double-click on the data control.

SoftContainer - [START_SLOT]

Figure 2-20 Opening the ”Properties” Dialog Box for the Data Control

Connecting the data control to the CPU 41x-2 PCI

Perform the following steps in order to set the CPU 41x-2 PCI as the control
engine:

1. In the ”Properties” dialog box of the data control, open the “Engine” tab to
display the options for the control engine (refer to Figure 2-21).

2. Select the “Direct Connect” option.

3. In the ”Control Engine” box, enter: wcS7=3 or the symbolic name that you
assigned in the component configurator (refer to Section 2.1.2)

4. Select the “Apply” button to connect the data control to the CPU 41x-2 PCI.
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Note

If you click on the “Apply” button, your changes in the dialog box are confirmed,
but the dialog box remains open. If you click on the “OK” button, your changes in
the dialog box are confirmed and the dialog box is closed.

Siemens S7Data Control Properties

Connections EventsGeneral

Tag Source

Connect via Tag Source

OK Cancel Apply Help

Engine

Direct Connect

PC Name

Control Engine wcS7=3

Find

Specify wcS7=3 or the symbolic name
from the component configurator as the
control engine.

Name Select the option for a direct
connection.

Select the ”Apply” button.

Figure 2-21 Connecting the Data Control to WinAC
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Distributed Component Object Model
(DCOM)

In this appendix

WinAC allows you to communicate across networks using Microsoft’s Distributed
Component Object Model (DCOM). You can use DCOM to integrate distributed
applications by way of a network. A distributed application consists of multiple
processes or different computers that cooperate to accomplish a single task jointly.

DCOM is a set of Microsoft concepts and program interfaces in which client
programs can request services from server programs on other computers in a
network. The Component Object Model (COM) provides a set of interfaces that
allow clients and servers to communicate within the same computer.

Section Description Page

A.1 Using DCOM to Expand the Capabilities of WinAC A-2

A.2 Connecting to a Specific Control Engine over DCOM A-4

A
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A.1 Using DCOM to Expand the Capabilities of WinAC

You can run the components of WinAC on a standalone computer, as shown in
Figure A-1. In this model, this computer provides the complete control system.

PC 1

MPI = n

MPI cardCPU 416-2 PCI*

Siemens label control

Siemens edit control

Siemens slider control

Siemens S7 data control
DCOM 

components

MPI server

WinLC*

I/OI/O

Siemens button control

Third-party control

*: cannot be operated
simultaneously

Figure A-1 Using WinAC Components with DCOM on a Standalone Computer

You can also utilize Microsoft’s DCOM technology to create a network of
computers that cooperate to provide the control system for a machine or process.
Figure A-2 shows how one computer running an application that uses ActiveX
controls (from SIMATIC Computing) can use DCOM to communicate with a
different computer that uses WinLC (or other PLCs) to control a process. 

The Windows operating system features a configuration tool (dcomcnfg) for setting
up your DCOM security. Use this tool (Start –> Run –> <dcomcnfg>) to configure
the server and client computers.
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PC 1

PC 2

MPI = n

Network

MPI server

Client

Server

MPI cardWinLC* CPU 416-2 PCI*

DCOM 
components

Siemens S7 data control

DCOM 
components

WinAC configuration tool

I/OI/O

Note: STEP 7 cannot connect
to the MPI server using DCOM.

Third-party control

Siemens label control

Siemens edit control

Siemens slider control

Siemens button control

*: cannot be operated
simultaneously

Figure A-2 Using WinAC on Several Computers with DCOM
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A.2 Connecting to a Specific Control Engine over DCOM

As shown in Figure A-3, you can use the SIMATIC data control to connect your
program to a control engine residing on a different computer.

Note

If you set up SIMATIC Data Control for a direct connection to a control engine, you
cannot assign a tag file. In other words, you cannot use symbol names for the tags
in the control engine.

To use symbol names, select the option for connecting via a tag source and
browse to a tag file that contains symbols for only one control engine.  Use the
TagFile Configurator to create tag files and connect to control engines using
DCOM. See the SIMATIC Computing User Manual for information about using
STEP 7 and the TagFile Configurator.

PC 2PC 1

DCOM

CPU 41x-2 PCI

Siemens label control

Siemens edit control

Siemens slider control

Siemens button control

Third-party control

Siemens S7 data control

Figure A-3 Connecting to a Specific Control Engine over DCOM
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OLE for Process Control (OPC)

In this appendix

OLE for Process Control (OPC) provides a standard mechanism for
communicating with numerous data sources. It is immaterial in this case whether
these sources are machines in your factory or a database in your control room.
You can use the OPC server provided with the SIMATIC Computing software to
communicate with the control engine and thus provide access to the process data.
SIMATIC Computing provides an OPC server that allows any OPC client
application to access data in the control engine. SIMATIC Computing does not
provide any OPC client application.

SIMATIC Computing implements the mandatory interfaces, as defined in the OPC
documentation, version 2.0, from the OPC Foundation. SIMATIC Computing also
implements the IOPC BrowseServerAddressSpace interface.

OPC is based on the OLE/COM technology from Microsoft. For more information
about OPC, refer to the OPC specification OLE for Process Control Data Access
Standard, version 2.0 from the OPC Foundation.

Section Description Page

B.1 Using OPC with SIMATIC Computing B-2

B
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B.1 Using OPC with SIMATIC Computing

OPC allows you to access data from the plant floor and integrate the data into your
existing business systems. You can use off-the-shelf tools (such as SCADA
packages, databases, spreadsheets) to assemble a system that meets your
needs. As shown in Figure B-1, OPC provides an open and effective
communication architecture which concentrates on data access and not the types
of data. 

OPC Client Interface OPC Client Interface

OPC Server
A

SIMATIC Computing OPC Server

OPCServer.WinAC

OPC Server
C

Application
X

Application
Y

Figure B-1 Applications Working with Many OPC Servers

Your OPC client connects to the OPC server object provided by SIMATIC
Computing. Due to this connection, you can create and edit OPC groups. OPC
groups structure the data that are accessed. You can activate or deactivate a
group as a unit, or you can “subscribe” to the list in a group of items so that you
can be notified when the data change. (A group is a collection of items.) Figure B-2
shows the connection from the OPC client application through WinAC to the
process data. 

Third-party OPC client application

Distributed I/O

WinAC

SIMATIC Computing: OPCServer.WinAC

Control engine

Figure B-2 Using the WinAC OPC Server to Access Your Process Data

To access the OPC server provided by the SIMATIC Computing software, select
OPCServer.WinAC with you OPC client.
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